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That’s Canada…with a “u”!

BC BRANCH

In December, the streets of Vancouver 
turn into a veritable theatre of shoppers 

bustling to find the perfect gift, which, 
for some, resides simply in the pages of 
a book. Canadian literature has finally 
gained long-deserved recognition 
internationally, but has the increased 
availability of Canadian books in other 
markets come at a cultural cost?

More and more Canadian publishers 
are using American spelling to target 
the comparatively larger consumer base 
to the south, so I questioned industry 
professionals and book-buyers waiting 
in holiday line-ups in search of…an 
indication as to whether this shift in the 
industry could spell the end for Canadian 
orthographic convention.

Whether they like it or not, Canadian 
publishers are being forced to tailor the 
spelling of their books to an American 
audience, which is 10 times the size of 
Canada’s, simply to remain financially 
viable. “We are doing more American 
spelling because we are selling into the 
states,” admits Nancy Flight, editor at 
local Canadian publisher Greystone 
Books. And she adds, “some authors are 
really upset about it.”

The sacrificing of Canadian spelling has 
also saddened many Canadian editors, 
even though they understand the economic 
reasons behind the decision. “Americans,” 
states Liv Fredricksen, “typically like 
things to be placed within their own frame 
of reference, and they have the buying 
power to demand that the rest of the world 
comply.”

As a grade two teacher, Audrey Owen 
makes a point of teaching Canadian 
spelling and that other spellings also exist. 
However, as a freelance editor, she uses 
American spelling on her website “to 
appear credible to the largest market.”

Why do Canadians spell it “colour” and 
Americans “color,” anyway? In order to 
make the English language more efficient, 
Noah Webster, creator of the American 
dictionary of the same name, removed 
superfluous and silent letters such as the 

“u” from the British spelling of words like 
colour. However, his primary object for 
these changes stemmed from a deliberate 
attempt in the post-War of Independence 
era to create an American spelling distinct 
from the British. He insisted a uniquely 
American spelling would not only develop 
a separate publishing industry in the States 
but also a strong national identity. As he 
wrote, “a national language is a band of 
national union.”

Webster was so successful in his ambitions 
that it is now the strength of the American 
national identity and its publishing 
industry that are causing Canadians to 
conform to American spelling conventions 
at the cost of their own.

Canada never had its own die-hard 
lexicographer with financial aspirations 
for the nation and a patriotic fervour 
driving the standardization of Canadian 
spelling. It’s been Canada’s history to be 
squished between the bookends of British 
and American conventions, and Canadian 
spelling—a cultural intertwining of these 
two influences—is just another example of 
our country’s “compromising” nature.

“Who says there is a ‘Canadian’ spelling?” 
remarks American editor David Dressler, 
living in Canada since 1965 and frustrated 
with all the back and forth of the “u.” As 
I soon learned, Canadians do. Without 
hesitation, Canadian participants in an 
informal and brief quiz I conducted at 
the UBC bookstore instantly identified 
“theatre” and “colour” as Canadian 
spelling. “I like the o-u-r,” stated Elaine 
Liau who had Canadian spelling ingrained 
in her as a child.

Madeline Merja from Montana was 
actually unaware Canadians had their own 
spelling before coming to Canada, but 
she believes Canadians should keep it, 
as it makes them “unique and different.” 
Peter Martin, originally from Scotland, 
also agreed: “It’s important to retain your 
culture.” Being Canadian “loses its soul,” 
otherwise.

Will Canadian spelling survive? Some 
said yes; some said no. “We made a 
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change to American spelling, which was 
heartbreaking because the demise of our 
spelling is bound to follow,” remarked 
Colleen MacMillan of Canadian children’s 
publisher Annick Press. Nonetheless, 
all Canadians I interviewed felt a strong 
attachment to Canadian spelling, and 
all participants, except one, realized its 
cultural value and importance for national 
identity.

“Language is about communicating, not 
identity,” stated American editor David 
Dressler. “It is a bridge, if anything, 
between cultures. To make the bridge the 
identity instead of a tool to communicate 
is ridiculous.”

That may be true, but if so, then why 
did Noah Webster believe an American 
spelling was linked to national identity? 
Why don’t Americans simply change to 
British or even Canadian convention? 
And why then did so many members of 
the EAC-BC respond passionately to my 
inquiry on the fate of Canadian spelling?

Maybe Canadians aren’t as attached to the 
“u” as we think we are but rather more 
attached to what it represents—the fact 
that we are not the same, that we have our 
own national identity, that we are proud of 
it and that we will long to preserve it no 
matter how stubborn and insignificant it 
may seem to our neighbours to the south.

Robyn Matthew
robyn@thelasource.com

Reprinted by permission
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Where Did That File Go?

A place for everything and everything in 
its place. That’s what my mother always 
taught me. It’s a good rule for life and an 
especially good rule for managing your 
computer files. Good file management can 
help you quickly locate files, group related 
documents together, move groups of data 
easily, facilitate file sharing, and help to 
back up important data quickly and easily. 
How do you achieve this? Keep in mind 
these three simple rules.

1. Choose a suitable file name

File names need to meet two criteria: 
they must be 1) meaningful to you; and 
2) easily recognized by others. Imagine 
being a photo editor who receives 20 
email attachments all called PIC004.jpg. 
This common digital file name makes 
sense to the sender but is an administrative 
nightmare to the receiver. So, to make it 
easier on yourself and others, try to find a 
name that truly describes the content of the 
file. In our example, the PIC004.jpg file 
could be renamed as rocky.jpg to indicate 
a peak in the Rocky Mountains. Further 
description could include rockyrobson to 
indicate the photo is about Mount Robson. 
By adding the sender’s initials, we create 
a unique file name that has less chance of 
getting confused with other files. Now the 
file name reads rockyrobson.sb.jpg.

Some other naming conventions might 
include the date (2.15.05) an acronym 
(CBC), a proper name (Sandy Beaches), 
or file type (Policy Manual). Using a good 
file name not only helps you and your 
readers but also makes searching for your 
files easier. Whatever name you choose, 
try to keep your file names under 14 
characters long. Some software programs 
cannot process files with longer names. 

2. Group similar files together

Consider ways to group the files you need 
together under a single folder. Common 
file management practices might group 
projects, subjects, people, or departments. 
To create folders, simply click on the 
directory where you plan to save your 
files (C:\Drive\My Documents). Select 
File>New Folder. A folder called New 
Folder will appear. To rename the folder, 
right-click on the new folder, select 
Rename, and type in your new name. You 
can create subfolders in the same manner. 
This time select the folder instead of the 
directory.

To illustrate a possible grouping, you 
might create a folder system that describes 
a documentation process. Let’s say under a 
main folder called PolicyManual you have 
sub-folders named, Text, Images, Draft, 
Review, Revisions, Approved, Final, and 
Distribution. These folder names reflect 
the type of work required and represent 
the process needed to complete the task. 

You can use your Save As feature to save 
files to different directories or drag and 
drop them from folder to folder.

+0 My Documents

+0 PolicyManual

+0 Text
+0 Images
+0 Draft
+0 Review
+0 Revisions
+0 Approved
+0 Final
+0 Distribution 

If you were working on more than 
one policy manual, you might use an 
acronym system to represent the different 
documents. For example, you could have 
folder names such as HRPolicyManual 
(for human resources), PRPolicyManual 
(for production), or OPPolicyManual (for 
operations). This is one way of naming 
folders, like naming files, to indicate the 
content of your information.

3.  Archive your files

Archive your files at least once a month 
or, for critical projects, once a week. 
What’s archiving? Archiving is the act of 
a true file management genius. The goal of 
archiving is to preserve all your computer 
files in such a way that you retain all your 
valuable information and hard work. This 
might include saving drafts, revisions, new 
versions, and final files all in one place. 
It’s not as hard as it sounds. 

Create a major Archive folder on your 
hard drive. Then, by holding down your 
Shift key and selecting all your working 
files, go to File>Edit>Copy. After telling 
your computer you want to copy these 
files, select the Archive folder and choose 
File>Edit>Paste. This will put a copy of 
the file into your archive folder. Then, 
copy the Archive folder to save to a floppy 
disk or memory stick or burn it on to a 
CD. Now your files are safely secured in 
three places and, should the worst happen, 
you have a record of all your hard work. 

Other archiving ideas might include saving 
files by year, month, product, semester, 
or season. For further safeguarding, email 
your files to someone else for safekeeping. 
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If you find your files are taking up a lot of 
memory, try using a compression software 
program like WinZip or StuffIt to reduce 
the file size. The key to archiving is finding 
a system and routine that works for you.  

A final word of advice: take time to learn 
the ins and outs of your computer’s file 
management tools. Windows Explorer for 
PC is a powerful tool for organizing your 
files. Mac OS is equally efficient. Learn 
how to copy, paste, drag, and drop your 
files so you can organize at will. It’s a skill 
you’ll never regret and you’ll be sure to 
impress your mother.

Watch for next month’s issue when Derek 
Miller, our resident computer guru, takes a 
closer look at backing up and saving your 
files.

Kelly Parry
kelly-parry@telus.net

Webopedia

Do you think a hard drive is a baseball 
term? Was the last time you touched a 
floppy disk just after your four-year-old 
put his frisbee in the microwave? Well, 
now you can learn the truth about all 
those computer terms and acronyms at 
<www.webopedia.com>.

Webopedia is an online computer 
dictionary whose computer definitions 
are created by real computer users. Check 
out the most frequently searched terms or 
search for a term of your own.  Browse 
around and learn what POP, SMTP, and 
FTP mean. We’re not going to tell you 
what they mean, you’ll have to visit 
Webopedia yourself.

The Pinstripe Suit Editor

At our January 19 meeting, writer, editor, 
and EAC-BC member Leigh MacKay 
presented his insights into writing 
and editing for the corporate world. 
Corporations employ editors and writers 
in a wide capacity to produce documents 
such as human resource manuals, health 
and safety manuals, policy and procedure 
manuals, instructions, and company style 
guides, among many others.
Leigh shared his experience managing 

corporate documentation, single-source 
documentation, working with Microsoft 
Word templates, establishing a company 
style guide and word list, document 
quality control through an effective editing 
process, and training casual Microsoft 
Word users in the office on how to get 
more from the program.

Style Guides 

When preparing a company style guide, 
consider the following:

• a list of acronyms and jargon
• plain language principles
• word list
• dates
• pronoun and punctuation rules
• company procedural information

Wonderful Word 

Word has many features that writers and 
editors may find useful:

• tables
• pilcrow paragraph marks
• Find and Replace
• different views (Normal, Outline,  
 Print Layout)
• paragraph styles

Leigh provided examples of keyboard 
shortcuts to make writing and editing more 
efficient. These and other tips can be found 
in the Help menu of Word.

Document accessibility

Three simple suggestions for redesigning 
lab and procedural documents to increase 
their readability:
 
• Create white space.
• Use bulleted and numbered lists.
• Use head and subheads.

Above all, keep the end-user happy!

Leigh MacKay is a graduate of the 
Douglas College Print Futures: 
Professional Writing program, and was a 
broadcaster for 30 years before entering the 
realm of the written word. He has managed 
the documentation needs of organizations 
such as the Neil Squire Foundation and BC 
Biomedical Laboratories Ltd.

Survey Says!

In last month’s issue we asked, “What 
is the best advice you can give an editor 
at the start of their career?” But sadly, 
we received no response.  Maybe once a 
month is too much for such a survey. So 
we’ll try one more time and if we still 
get no replies, we’ll run the Survey Says! 
column only bi-monthly. This month’s 
question is:
 
“When should an editor stop editing?”

Please email your replies or suggestions 
for future questions to 
<westcoasteditor@editors.ca>.

We’ll publish selected answers in the next 
issue.

If you were unable to attend Leigh’s 
presentation, log on to <www.editors.ca> 
and listen to the meeting in MP3 format.

Ashley Mikulik
a_mikulik@uniserve.com

Starting and Sustaining Your 
Editing Career

A big thank you goes to EAC/ACR 
national vice-president, Maureen 
Nicholson, for presenting her always 
popular workshop, Starting and Sustaining 
Your Editing Career, held last November 
20 at SFU Harbour Centre.

Before a minute had passed at the 
session opening, Maureen taught the 
first of her many invaluable lessons. 
Asked to exchange business cards with 
their neighbours, many registrants were 
caught off guard, quickly realizing that 
in the freelance world you must always 
be prepared to promote yourself as an 
editor—even in a roomful of  ‘em!

Maureen shared valuable tips on a myriad 
of topics, from starting and sustaining an 
editing career, sole proprietorships,
partnerships, and corporations. She 
focused on the fact that in order to make 
decent coin as an editor, one can’t ignore 
nitty-gritty practicalities.

Continued on page 4



Spring Workshops

Don’t forget to mark these upcoming 
spring workshop dates on your calendar:

February 26
Plain Language: The Basics
Peter Moskos

March 12
Onscreen Editing with Microsoft Word
Derek Miller

April 9
Editing with Style
Peter Moskos

Watch for details of workshops 
in upcoming issues or email 
<bcworkshops@editors.ca> for a 
workshop brochure.

Next Meeting

February 16, 2005 @ 7:30 pm
YWCA Health and Wellness Centre, 

Welch Room, 4th Floor,
535 Hornby Street, Vancouver

Join us for speaker Cathy Stonehouse, 
editor of Event magazine. Cathy’s 
presentation will highlight the joys and 
challenges—and the pros and cons—of 
editing an established literary journal 
for aspiring writers and editors. She will 
outline what the job entails, assessing 
current obstacles and opportunities 
looming in the field of small magazine 
publishing.

EAC/ACR members attend monthly 
meetings at no charge. Please note that 
non-members now pay $10 ($5 for 
students with valid ID). Light refreshments 
are available. Please check the EAC/ACR 
website for details.

To download MP3 files of past meeting 
presentations, go to this link: 
www.editors.ca/bc/meetings.htm.
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This includes clearly spelling out contract 
terms and really knowing your personal 
and professional limits.

By the end of the day, Maureen had 
answered every question posed at the 
beginning of the workshop, plus more. As 
one satisfied registrant wrote, “It was great 
as is—just bring Maureen back next time!” 
Here’s what other people had to say about 
the workshop:

• a crash course in how to proceed 
• very informative
• practical, realistic information
• a realistic overview of what the  
 editing field is really about
• Maureen presented her expertise/ 
 knowledge clearly while also listening  
 to what others were saying
• Maureen is an engaging and   
 informed speaker with endless   
 resources.

With more than 20 years’ experience 
in writing and editing, Maureen is 
currently the coordinator for the Print 
Futures: Professional Writing program 
at Douglas College. She also operates 
Keyline Consulting Associates, a writing 
and editorial services company for trade 
publishers, educational institutions, and 
non-profit organizations.

Wendy Harris
Professional Development
bcworkshops@editors.ca

What’s On

Thursday, February 10 
Declarations of Love—Character and 
Dialogue in Romantic Fiction
Co-sponsored by the Romance Writers of 
America, Greater Vancouver Chapter and 
the Vancouver Public Library
Phone 604-331-3603 for details.

Monday, February 14
Letterpress Book: Start to Finish 
Co-sponsored by the BC Book Arts Guild 
and the Vancouver Public Library 
Phone 604-331-3603 for details.
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